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AAAnnnnnnuuuaaalll   RRRooouuunnndddtttaaabbbllleee   DDDiiissscccuuussssssiiiooonnn                                                            
&&&   UUUssseeeddd   EEEqqquuuiiipppmmmeeennnttt   SSSaaallleee   aaa   sssuuucccccceeessssss!!!   

Last month's annual Labor Day Weekend meeting (Roundtable Discussions and Used Equipment Sale) 
was a success, albeit with a bit of controversy.  It was deemed a success (by this Editor) due to two facts:    

1. We saw an unusually high turnout for the meeting.  Historically, our Labor Day Weekend meetings 
have resulted in low turnouts; the past two years have seen crowds of 40 - 50!   
2.  The Used Equipment Sale resulted in over $450 donated to the club from the sales. 

Regarding the controversy part, I'd like to offer my opinions: 
Someone said the Roundtable Discussions are targeted toward improving our photographic knowledge, but 
noted that this year's discussions were about other topics.  I've always understood that the Roundtable 
Discussions have intended to be about whatever you wanted to discuss photographically, whether it was 
educational or not.  Personally, I liked the pro and con discussions about scanning a lifetime supply of 
slide film; and I learned that Nikon does not support Windows 7 software for its scanners (thanks to that bit 
of information, I found $40 & $80 VueScan software that does, as well as $400 Silverfast). 
Thanks to the generosity of Adair Photography and others who donated equipment to the club for sale, we 
realized a pretty darned good increase in our club treasury!  However, I suspect that most sales by other 
members were minimal or non-existent.  I believe a good reason is that most of the merchandise brought to 
the sale was too old to be of value to most of us.  Should we require all sale merchandise be no more than 
20 years old?  Perhaps that's a future discussion point for our board... 
 
 
 
 
  
 
 
 

R e d l a n d s  C a m e r a  C l u b  

R e d l a n d s  C a m e r a  C l u b  

October  45 

HOW EDITORS SEE 
PHOTOGRAPHS 

Rob Sheppard 

November  1 

MEMBERS'     
NIGHT 

Bring up to 4 images 
 

November  15 

TO BE 
ANNOUNCED 

David Cochrane 
 

October 18 

BRYCE  
CANYON  

RCC Field Trip Attendees 

Redlands Camera Club is a group of amateur, serious-amateur, and professional photographers who are interested 
in sharing experiences and advancing their skills.  Anyone with similar interests is encouraged to attend a meeting: 

no cost or obligation.  We meet at 7:00 pm on the first and third Mondays of every month at                                                                      
Redlands United Church of Christ, 168 Bellevue Avenue, Redlands, CA. 
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Redlands Camera Club   P.O. Box 7261  Redlands, CA  92375 
www.RedlandsCameraClub.com 

CLUB OFFICERS 
President: Bruce Bonnett      Vice President: Bruce Woodcock        Past President: Judith Sparhawk 

Secretary: Jerry Reece  Treasurer: Rick Strobaugh 
CHAIRS 

Circulation: Karen Fabrizio Competition: Wayne Wood  Exhibits: Carol Abidin     Education: Frank Peele 
Field Trips: Judith Sparhawk  Hospitality: Steve Oberholtzer       Librarian: Mike Reid 

 Member-At-Large: Larry Cowles   Membership: Bessie Reece   Photogram Editor: Steve Felber 
Programs: Bruce Woodcock  Publicity: Nancy Yowell  Webmaster: Wayne Wood 

THE VIEW FROM HERE 
 Bruce Bonnett 

 
 

This past Monday, I attended Frank Peele's workshop On-Camera Flash: Get All the Light You Need – and 
Not One Bit More.  As always, Frank presented an excellent learning experience for those in attendance.  
We're grateful not only to Frank for sharing his vast knowledge but also to ShutterStories for providing a 
great environment for the workshops.  I'm not going to go into the details of the workshop but I am going 
to dig into my cache of older flash equipment and explore new ways of using what I have to create more 
interesting lighting for my photography. 

Our Workshop series is a great member benefit that I would encourage everyone to take advantage of.  
Frank currently has planned workshops for the remainder of our fiscal year on the following topics: 

Up Close: The ins and outs of macro photography (November) 
Studio Lighting: Introduction to using hot lights and strobes in a controlled environment (January) 
People Photos: Lighting and posing formal, informal, and candid portraits (March)  

As workshop class size is limited, you'll want to register for these workshops as soon as registration begins 
to ensure that you won't miss out.  Details about upcoming workshops will be in the Photogram (thanks 
Steve) and on the website, www.redlandscameraclub.com

Both the Photogram and the website also identify other membership benefits and learning opportunities, so 
please take advantage of them.  Woody has added a lot of interesting and informative links to tutorials, 
videos, and other sites that will help us all expand our photographic and artistic skills.  Take advantage of 
the other opportunities that the club offers too.  Field trips (Judith), exhibits (Carol), the various 
competitions (Woody), and the meeting programs (Bruce – the other one); all offer a banquet of 
experiences. 

 (thanks Woody).   

Thank you to all of the other Board and committee members who help ensure the club runs smoothly.  And 
thanks to all of you; it is your club and it's your attendance, participation, ideas, and willingness to serve 
that make it successful.  
 
 
Maybe now would be a good time to start thinking about the images you are going to enter in the 2010 
Winter Digital Competition. 
Sometimes I can be the king of procrastinators. Why do it today when tomorrow would be better.  
The upcoming Winter Digital Competition will be my last as Competition Chairman.  It's time to turn the 
reins over to someone else.  Stay tuned for the announcement of your new Competition Chairman.  
If any member  has any photography related videos on YouTube and would like me to place a link to them 
on our web site just email the link to me and I will make sure they get placed.    

WEBMASTER/COMPETITION 
      Wayne (Woody) Wood 
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How does an editor look at images? What makes one image stand 
out from another? 

Rob Sheppard, long time Editor of Outdoor Photographer magazine 
and currently Editor-At-Large, will give us some insights on what 
makes a photo communicate and stand out. 

 

 

Whatever happened to that field trip to Bryce Canyon National Park 
that was promoted last May?  Well, tonight you'll find out.  You'll 
get to see the pictures taken by those who attended, hear stories of the trip, and even learn a little about the 
geographical history of the canyon.  The attendees were Kish Doyle, Steve & Nancy Felber, George & 
Connie Johnson, Rick Strobaugh, and Jim Wilson.  Rick has put together an interesting and dynamic 
presentation for you.  Who knows?  Perhaps it will motivate you to put together an out-of-town field trip 
of your own! 

 
 

** Update  Joshua Tree National Monument—Keys Ranch Trips Update** 

The dates for the two field trips planned for October to Keys Ranch in Joshua Tree National Monument 
are Thursday, October 7th  and Saturday October 23rd .  These limited-participant trips are full, so this 
information is for those already signed up.   

Please note that there has been a time change from that originally announced.   

This is the time change: Please note!  These are early morning trips.  We are required to be at the gate 
for Keys Ranch at 6:45 am, and our guide will take us in at 7:00.  Our shooting time is 7:00 to 9:00, 
and our twelve participants will be the only ones there, other than the volunteer guide.  We can have 
tripods, which are not allowed on regular Keys Ranch tours.   

We should carpool as much as possible, as there’s only so much space to park at the gate.  Also, we have 
to pay entrance fees of $15 per car, for those not having an annual pass or Golden Access Pass (for 
us old codgers).  

It is about 80 miles from Redlands to the Keys Ranch gate.  When I did a dry run for time and mileage, it 
took about 1.5 hours.  Early morning may be faster, but I would allow a little extra time, just in case.  
Carpoolers should plan to meet at 4:45 am (yikes!) at the latest, to leave by 5:00 at the latest.  Meet at 
Coco’s in Redlands. 

Directions:  Go east on I-10 to Hwy 62, going north toward Joshua Tree and 29 Palms. 

Continue on Hwy 62 into the town of Joshua Tree and turn right on Park Street, following the signs to 
JTNM.  Continue on Park, passing the entrance kiosk (paying if they are open), and stay on the same road, 
past Hidden Valley Campground, to a fork in the road.  Go left toward Keys Ranch, following the signs.  
There is a locked gate with parking.  We will be met there by our guide.  Be there by 6:45!  If you aren’t 
there when our guide takes us in, you can’t go in later on your own.  

FIELD TRIPS 
      Judith Sparhawk 

OCTOBER  4TH                   
How Editors See Photographs:  Rob Sheppard 

OCTOBER  18TH                   
Bryce Canyon field trip; presentation by attendees 

UPCOMING PROGRAMS 
       Bruce Woodcock 
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Exhibit Schedule for 2010 
 

Where 
Hanging 

Dates 
Take-In 
Times 

Redlands City Hall February 11 3 – 5 

Redlands Community Hospital March 6 10 - Noon 

Redlands City Hall April 8 3 – 5 

Redlands Community Hospital May 8 10 - Noon 

Redlands City Hall June 3 3 – 5 

Redlands Community Hospital July 10 10 - Noon 

Redlands City Hall August 5 3 – 5 

Redlands Community Hospital September 11 10 - Noon 

Redlands City Hall October 7 3 – 5 

Redlands Community Hospital November 6 10 - Noon 

Redlands City Hall December 2 3 – 5 

 MEMBERSHIP 
Bessie Reece PRINT EXHIBIT RULES 

The work must be yours, a current member of RCC.   
It must be ready to hang using wire eyes & wire; 

no saw tooth hangers.   
You may use a frameless presentation. 

Your name, title of the picture, and sale price (if for sale)                       
must be on the back. 

There is a $3.00 fee for each work hung: cash or check. 
Work left for another hanging will be charged again. 
Work removed but not retrieved after a new hanging                             

will be charged a $3.00 storage fee. 
Work unclaimed within 60 days of removal will be considered 

abandoned and become the property of Redlands Camera Club                    
for disposal or sale at its sole discretion. 

Photoshop & Elements tip:  Performance Preferences 
Two adjustments in Preferences in Photoshop or Elements can help improve performance.                          

Go to Edit > Preferences > Performance to make the adjustments. 

Memory Usage can let you specify how much of your RAM you would like to                                            
dedicate to the use of Photoshop or Elements.  Naturally, you would like to use whatever is left                                                     

after your computer uses that which is needed to run the rest of your system. 

You also have the option of setting up a Scratch Disk.  Think of a Scratch Disk as temporary RAM 
created by using actual hard drive space.  It is employed after your RAM is filled up.                                  

Adobe suggests this Scratch Disk not be on the C: drive;                                                                                  
so assigning it to a second hard drive is preferred. 

 

Photoshop & Elements tip:  Turn the Background Layer into a Regular Layer 
By default, your Background Layer is locked and you can't move it.  But by double-clicking on its gray 

area in the Layer Palette, the New Layer dialogue box will appear with "Layer 0" highlighted.   

You may either leave it named as such, or rename it to something more meaningful to you.                                
Click the OK button and it's now a Regular Layer. 

 

 
Next Hanging: Redlands City Hall 

Thursday, Oct. 7 from 3:00 to 5:00 
Join your club members and bring a photograph to  
show the community our talents at RCC. See the Print  
Exhibit Rules for requirements and be sure to have 
your name and phone number on the back of our 
image. 

If you have photographs currently hanging that have 
not been sold, you can let them hang again and/or bring 
new ones with a cost of only $3.00 for each. 

After hanging your pictures, bring friends and family  
to show them what RCC is all about.  

Many thanks to all who assisted with membership while 
I have been out of town.  I'll be home October 4, and I 
will catch up on the new member bios next month.  

For all that joined during September, welcome. I look 
forward to meeting you.   

Name badges for our new members will be on the board 
the second meeting in October. 

                                                                         

EXHIBITS 
      Carol Abidin 
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Reduce Noise using Layer Stacks (Photoshop only) 
Noise is rarely in exactly the same place from one picture to another.                                                                   
So take multiple exposures (three to five is good) of the same image.                                                                

Photoshop will search for the differences between the exposures and blend them,                                              
keeping what stays the same and eliminating what is different (the noise spots). 

Go to Open>Scripts>Load Files into Stack.                                                                                                                         
In the dialogue box that appears, Browse to find your multiple exposures to open.                                                 

Check the Attempt to Automatically Align Source Images                                                                                              
and Create Smart Object after Loading Layers boxes, then click OK.                                                                        

Next, select Smart Objects>Stack Mode>Mean or Median.                                                                             
Mean works best for images with no motion in them;                                                                                    

Median is best for images with some motion                                                                                                 
(tripods aren't required, but a steady hand is helpful). 

Sit back and watch Photoshop work its magic!                                                                                                         
Random noise between the exposures will be reduced substantially,                                                             

maybe even dramatically.  However, this technique  won't eliminate fixed noise,                                              
hot pixels, or column and row noise. 

The most challenging part of this technique is identifying situations where noise will be prevalent                    
(like large blue skies) and remembering to make those multiple exposures. 

Photoshop & Elements tip:                                                                                                                     
Differences between Flatten Image, Merge Visible, and Merge Down commands 

The Flatten Image command will flatten all layers, blending layers that are visible                                              
and discarding layers that are not visible.                                                                                                                

If you use the Flatten Image command the appearance of the image should not change. 

The Merge Visible command will merge all layers that are currently visible,                                                 
keeping separate only layers that are not currently visible (eye is no longer checked).                                     

The Merge Visible command should not change the appearance of the image,                                                  
with the understanding that of course the image has changed in appearance to some extent by virtue of 

the fact that you've turned off the visibility of some layers.                                                                               
But when you apply the Merge Visible command the currently visible layers will be flattened, so the 

appearance of the resulting image should not change.                                                                                    
When you make the additional layers visible the appearance of the image may very well change,                             

but the merged layers should appear the same after they are flattened. 

The Merge Down command will merge the current layer with the layer directly below.                            
The Merge Down command is the one that is most likely to create a change in appearance.                           

This command will merge the current layer with the layer below it.                                                                    
This can have significant effects on the appearance of the image.                                                                   

For example, if the layer that is currently selected is an adjustment layer,                                                      
and the layer below is one image in a composite,                                                                                            

when you Merge Down only the layer directly below the adjustment layer will be affected                                
by that adjustment layer, and the layers below will not be affected. 
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Redlands Camera Club solicits sponsorship only from reputable businesses who sell high quality products and services at                         
reasonable prices, and whose business philosophies and customer service actions reflect fair decisions from the customer point of view.. 

Redlands Camera Club recommends its members consider the financial investment to our club  made by these sponsors,                                   
and give serious consideration to them when making buying decisions. 

 

SPONSORS 

On a space-available basis, Notices, Requests and For Sale ads may be posted by any member.  300 dpi JPEG pictures may be included..   
All postings must be photography-related and include your name and contact information.                                                               

See Photogram Submissions box for deadline and submission information. 

RCC Bulletin Board 

NOTICE 
 

Any RCC member in good standing 
can place photography-related ads           

on our Bulletin Board                                   
on a space-available basis. 

 
Just send an email to the Editor             
with the pertinent information                  

and an ad can be created.                            
Or you can create your own ads                 
and email them as attachments. 
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Photoshop & Elements tip:  Why Adjustment Layers vs. Adjustments?   
Levels, Curves, Brightness/Contrast, Hue/Saturation, etc. 

Adjustment Layers (Layer > New Adjustment Layer) provide a significant benefit in flexibility                         
and image quality over adjustments made directly to the Background image layer                                    

(such as: PHOTOSHOP: Image > Adjustments or ELEMENTS: Enhance > Adjust Lighting). 
Adjustment Layers do not significantly enlarge the file size.                                                                          

The layer size is small, since they do not directly affect the actual pixels,                                                       
but are merely a set of instructions on how to modify them. 

Conversely, adjustments to the Background image layer change the pixel values –                                                      
permanently, once the file is saved.   

Adjustment Layers are non-destructive.                                                                                                  
You will always have the ability to change their effects to the image. 

With adjustments to the Background image layer, if you make five different adjustments,                
then later decide to modify one of them, you must scrap them all and begin anew.   

Adjustment Layers allow you to return to each one separately for tweaking. 
Adjustment Layers offer the ability to click the eye on and off,                                                                 

thereby showing you the Before and After effects of those adjustments. 
Applying multiple adjustments directly to the Background image layer                                                       

creates the potential to gradually reduce the amount of information in an image.                                                                      
This can eventually lead to some level of posterization                                                                                    

(the loss of smooth gradations of tone or color).                                                                                            
For example, if you apply a Levels adjustment, then go back and adjust several more times                                                

to fine-tune the image, you will introduce a more degrading effect than if you had used a single 
Adjustment Layer of Levels and tweaked it several times.                                                                                                                  

Regardless of how many times you tweak an Adjustment Layer,                                                                      
it only counts as a single adjustment and does not compound the effect in terms of posterization. 

An Adjustment Layer automatically includes a Layer Mask.                                                                             
It’s the white box to the right of the adjustment icon in the layer.                                                                     

By clicking on it, then selecting a Brush size, you can fine-tune the adjustment                                                
to local areas within the image.                                                                                                                        

For example, if you brightened the image using Levels, but don’t want it to effect one area,                           
you could Mask that area by brushing over it –                                                                                                

even to the point of changing the Opacity of the mask so the effect was cut by 40% or 70%. 
 

Photography tip:  Hyperfocal Distance 
Call it a zone of acceptable sharpness.   

It is a useful feature that is the function of the lens focal length, aperture (f- stop), and distance.             
When you focus your lens, there will be a zone that appears to be in focus,                                                  

and areas that are out of focus.                                                                                                                      
The area that appears to be in focus is called the zone of acceptable sharpness.                                                     

While technically it's not in focus (only the actual point of focus is),                                                                
most of this zone is sharp enough that it appears to be in focus. 

When you focus on a subject, one third of the zone of acceptable sharpness is between                              
that point and the camera, and two thirds of the zone is behind the point of focus. 

Here’s one way to use it: when shooting landscapes, use the Rule Of Thirds                                               
and focus at a point near the bottom third line.                                                                                              

That way you will get an additional area in front of distant objects that appears to be sharp. 
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Redlands United Church of Christ 
168 Bellevue, Redlands, CA 

Redlands Camera Club 

7:00 p.m. -- 1st & 3rd Mondays 

 

WHERE 

WE MEET… 

Want to join or renew your membership? 
• Complete this form and bring it to a meeting, along with $20 annual dues, 

• Or  Mail to: P.O. Box 7261  Redlands, CA  92375 (make check payable to: Redlands Camera Club) 

Name: _____________________________  Phone:  (____)  ____ - _______ 

Street Address: ________________________________________________ 
City: ________________________________  ST: _____ ZIP:  ___________ 

E-Mail:  _______________________________________________________ 

New Member    Annual Renewal     


